Service Contact Information
For questions regarding service or technical information contact:

1-866-MAG-SERV
(1-866-624-7378)

Magnetek Material Handling
N49 W13650 Campbell Drive
Menomonee Falls, WI  53051

Telephone:  800-288-8178
Website:    www.magnetek.com
E-mail:     MHCustomerservice@magnetek.com

Fax Numbers:
Main:       800-298-3503
Sales:      262-783-3510
Service:    262-783-3508

Magnetek, Inc. has additional satellite locations for Canada and the United States. For more information, please visit http://www.magnetek.com.

©2017 MAGNETEK

All rights reserved. This notice applies to all copyrighted materials included with this product, including, but not limited to, this manual and software embodied within the product. This manual is intended for the sole use of the person(s) to whom it was provided, and any unauthorized distribution of the manual or dispersal of its contents is strictly forbidden. This manual may not be reproduced in whole or in part by any means whatsoever without the expressed written permission of MAGNETEK.
# Table of Contents

Service Contact Information .............................................................................................................................. 1

Chapter 1 - Introduction ........................................................................................................................................ 4
  Overview .................................................................................................................................................................. 4
  System Requirements ............................................................................................................................................. 4

Chapter 2 - Installation .......................................................................................................................................... 5
  Software Installation ................................................................................................................................................ 5
  Creating Communication Profiles using the Wizard ................................................................................................ 6

Chapter 3 - Navigation ........................................................................................................................................... 7

Chapter 4 - Parameter Maintenance .................................................................................................................. 10
  Read from VFD ...................................................................................................................................................... 10
  Write to VFD .......................................................................................................................................................... 10
  Parameter File Display .......................................................................................................................................... 11
  Modifying Parameters ......................................................................................................................................... 11
  Security / Password Protection .............................................................................................................................. 12
  Parameter File Comparison ................................................................................................................................ 12

Chapter 5 - Monitor Function ............................................................................................................................. 14
  Monitor ................................................................................................................................................................... 14
  Fault Reset ............................................................................................................................................................ 14

Chapter 6 - Additional Menu Features .............................................................................................................. 15
  Print Preview ........................................................................................................................................................ 15
  Parameter File Conversion .................................................................................................................................. 16
  Keypad Simulator ............................................................................................................................................... 16
  Viewing Parameters ............................................................................................................................................. 17
  Copying to the Clipboard ................................................................................................................................... 17

Chapter 7 - Troubleshooting ............................................................................................................................... 18
  Drive Fault References ....................................................................................................................................... 18
  Communication Error References ........................................................................................................................ 19
  Communication Profile Test ................................................................................................................................. 20
  Status Log ............................................................................................................................................................ 20
Warning and Caution

DISCLAIMER OF WARRANTY

Magnetek, hereafter referred to as Company, assumes no responsibility for improper programming of a drive that resulted from use of this software. This software should only be used by a trained technician who has read and understands the contents of this manual. Normal use of this software may result in the drive parameters becoming modified. Improper programming of a drive can lead to unexpected, undesirable, or unsafe operation or performance of the drive. This may result in damage to equipment or personal injury. Company shall not be liable for economic loss, property damage, or other consequential damages or physical injury sustained by the purchaser or by any third party as a result of the use of this software. Company neither assumes nor authorizes any other person to assume for Company any other liability in connection with the sale or use of this software.

⚠️ WARNING

1. Read this user manual in its entirety before installing IMPULSE®-Link 4.1 Wireless Diagnostic System.
2. DO NOT connect or disconnect wiring, or perform signal checks while the electrical power is ON.
3. Improper programming of a drive through the use of this software can lead to unexpected, undesirable, or unsafe operation or performance of the drive.

Failure to observe these and other precautions indicated in this manual will expose the user to high voltages, resulting in serious injury or death. Damage to equipment may also occur.

⚠️ CAUTION

NOTICE

No patent liability is assumed with respect to the use of the information contained herein. Moreover, Magnetek is constantly improving its high quality product; therefore, the information contained in this manual is subject to change without notice. Every precaution has been taken in the preparation of this document. Nevertheless, Magnetek assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained in this publication.
Chapter 1 - Introduction

Overview

IMPULSE•Link 4.1 Basic is a user friendly, Windows® based, interactive drive communication software. It is designed for communication from your PC to the various Magnetek drives.

The IMPULSE•Link 4.1 Basic Kit (Part #: IL-4.1-BASIC-KIT) contains the following components:

1. USB flash drive containing IMPULSE•Link 4.1 Basic software installer.
2. Cable for IMPULSE•G+/VG+ Series 2 Drives.
3. Cable for IMPULSE•G+/VG+ Series 4, Series 3, and G+ Mini Drives.
4. Cable for OmniPulse DDC and DSD Drives.
5. USB-to-Serial converter.

Supported Drives

IMPULSE•Link 4.1 Basic supports the following Magnetek drives:

- IMPULSE®•G+/VG+ Series 4
- IMPULSE®•G+/VG+ Series 3
- IMPULSE®•G+/VG+ Series 2
- IMPULSE®•G+ Mini
- IMPULSE®•D+ HHP
- IMPULSE®•P3 Series 2
- OmniPulse™ DDC
- OmniPulse™ DSD
- MagnePulse™ DMC

System Requirements

PC Requirements

1. 256 MB RAM or greater
2. Minimum of 100 MB free hard-disk space available
3. Windows Vista, 7, 8, or 10
Chapter 2 - Installation

Software Installation

The IMPULSE®•Link 4.1 Basic flash drive contains: the IMPULSE®•Link 4.1 Basic software installer.

- To run the IMPULSE®•Link 4.1 Basic Setup, insert the IMPULSE®•Link 4.1 Basic installer flash drive into a USB port on your PC. Run the included .exe file.
- Select the default choices during installation and click “Finish” when complete.

Software Updates

Additional features and software enhancements may be available from time to time. These may be downloaded for free from the Magnetek Material Handling website at:

http://www.magnetekmh.com/Material Handling/Downloads
Creating Communication Profiles using the Wizard

If you need to create a communication profile, there is a wizard to assist you. In the Settings Menu, click “Communication”, and then right-click on the folder “Communications Profile” and choose “Add Crane Profile”.

Highlight the IMPULSE DRIVE, RS232 for the standard Serial connection, and then click “Select”. The wizard will then take you through the following three steps to set up a new communication profile.

1. Name, Description, Crane, and Motion
2. Common Port, Protocol, Slave Address, Baud Rate, Parity
3. Finish
4. To save, click OK on the Communication Profile screen
Chapter 3 - Navigation

IMPULSE•Link 4.1 Basic is a Windows-based software with easy to use menus and drop-down functions. The user is able to access utilities for uploading/downloading parameters, comparing parameters, saving parameters to a file, and more from the easy to navigate toolbar. The main screen allows the user to access more commonly used features.

New – Displays the menu to create a new factory default parameter set, based on the drive type, firmware version, model, and kVA.

Open – Opens or finds a file containing a parameter set for a specific drive type and firmware version.

Save – Saves the active file with its current file name and location.

Print – Prints the active parameter set. Select Print options, in the Print window/dialog box.

Print Preview – Shows how a file will look when you print it.

Log – Shows the status log.

Profile – Shows the selected profile.

Help – Provides information on communication profile settings and troubleshooting, complete Index of VFD fault codes, and a Search function.

Write to VFD – Saves all parameter values from the PC to the VFD.

Read from VFD - Loads all parameter values from the VFD to the PC.

Properties – Displays the properties box to view the properties of the active file.
The following gives a brief summary each of the functions that can be accessed from the navigation toolbar.

**New** – Opens a dialog to create a new factory default parameter set, based on the drive type, firmware version, model, and kVA.

**Open** – Opens a *.par file containing a parameter set for a specific drive type and firmware version.

**Close** – Closes the parameter file that’s currently open.

**Save** – Saves the active file with its current file name and location.

**Save As** – Saves the active file with a selectable file name and location.

**Print Preview** – Shows how a file will look when you print it.

**Print** – Prints the active parameter set with selectable options in the Print window/dialog box.

**Properties** – Displays the properties of the active file.

**Exit** – Closes this program after prompting you to save any unsaved files.

**Communication** – Allows communication profiles to be added, removed, edited, copied, imported, and exported.

**Preferences** – Settings for access level.

**Write Flash** – Allows a binary file to be written to VFD flash memory. (FACTORY USE ONLY)

**Read from VFD** – Loads all parameter values from the VFD to the PC.

**Write to VFD** – Saves all parameter values from the PC to the VFD.
- **Convert** – Allows for parameter files to be converted from one firmware version to another (must be within the same drive series).
- **Compare** – Allows for comparison between two different parameter files.
- **Communication Test** – Performs a communication test with the VFD.
- **Monitor** – Displays a select number of monitor parameters (U-parameters); updated continuously.
- **Keypad Simulator** – Emulates the keypad and allows for navigating the keypad menu remotely (this is not available unless hardwired to the keypad port).
- **Show Error Log** – Shows the status log.

**Window** – Allows for easy parameter window recall and organization. All open files are enumerated at the bottom of this menu for switching between files more easily.

**User Manual** – Displays the User Manual. (A .pdf reader, such as Adobe Acrobat Reader, must be installed)

**Impulse Link Help** – Provides information on communication profile settings and troubleshooting, complete Index of VFD fault codes, and a Search function.

**Magnetek Website** – Provides a link to the Magnetek Material Handling website.

**Check for Updates** – Provides a link to the Magnetek webpage that offers updates.

**About** – Displays the version number of this software, copyright, and legal notices.
Chapter 4 - Parameter Maintenance

IMPULSE®-Link 4.1 Basic software provides flexibility in programming, uploading, downloading, and saving parameters. With full parameter descriptions and visual programming, modifying parameters from your computer has never been easier.

Read from VFD

This function allows you to load the parameter values from a drive. This can be accomplished through the “VFD” drop down menu or by clicking the “Read” icon.

Write to VFD

This function transfers the parameter settings from your PC to the VFD. This can be accomplished via the drop down on the “VFD” menu or by clicking the “Write” icon. Writing to the VFD may result in undesirable operation of your crane, which may lead to bodily injury or damage to machinery. To proceed with the Write to VFD function, you will need to accept that you acknowledge the warning message as shown here. Once you have checked the “I Accept” box, the “Continue Write to VFD” button will be available.
Parameter File Display

Parameter Value Text Color

**Modified Constant**
A parameter with **blue** text implies that its value is different than its default setting.
- This list should match the modified constants list in the drive, with the exception of A1 parameters.

**Read-Only**
A **grayed-out**, highlighted parameter implies that it cannot be modified.
- The Access Level of the current parameter set is lower than what is needed for this specific parameter (i.e. changing this parameter from the drive keypad would not be allowed with the current access level).

**Over Maximum**
A parameter with **red** text implies that its value is greater than its maximum. An invalid value in the PAR file could result in this error.

**Under Minimum**
A parameter with **green** text implies that its value is less than its minimum. An invalid value in the PAR file could result in this error.

Modifying Parameters

1. Begin modifying a parameter by double-clicking on the setting cell.
2. A drop-down list or edit box will appear.
3. Press “Enter” to accept the change or “Escape” to cancel.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Setting</th>
<th>CD</th>
</tr>
</thead>
<tbody>
<tr>
<td>F5-04</td>
<td>DO Chn Select</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>F5-05</td>
<td>DO Chn Select</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>F5-06</td>
<td>DO Chn Select</td>
<td>DC Fan, Fan</td>
<td>x</td>
</tr>
<tr>
<td>F5-07</td>
<td>DO Chn Select</td>
<td>DC Fan, Fan,</td>
<td>x</td>
</tr>
<tr>
<td>F5-08</td>
<td>DO Chn Select</td>
<td>DC Fan, Fan,</td>
<td>x</td>
</tr>
<tr>
<td>F5-09</td>
<td>DO Chn Select</td>
<td>DC Fan, Fan,</td>
<td>x</td>
</tr>
<tr>
<td>F5-01</td>
<td>Comm Bus Pri Sel.</td>
<td></td>
<td>x</td>
</tr>
</tbody>
</table>

**Drop-down List Example.**
This is displayed for drive parameters with a finite list of options.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Setting</th>
<th>CD</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1-01</td>
<td>Input Voltage</td>
<td>230</td>
<td>x</td>
</tr>
<tr>
<td>E1-03</td>
<td>V/F Selection</td>
<td>160 Hz Saturation</td>
<td>x</td>
</tr>
<tr>
<td>E1-04</td>
<td>Max Frequency</td>
<td>60.0</td>
<td>x</td>
</tr>
<tr>
<td>E1-05</td>
<td>Max Voltage</td>
<td>230.0</td>
<td>x</td>
</tr>
</tbody>
</table>

**Edit Box Example**
This is displayed for drive parameters with a numeric range.

Notes:
1. If a change is made and ENTER is not pressed to accept it, when the user clicks on another row or column, the value will revert back to what it was before the change.
2. If a parameter is changed to an invalid value, under the minimum value or over the maximum value, a warning message will be displayed and the value being edited will revert back to what it was before the change.
Visual Programming

Visual Programming is an additional editing option targeted towards more complicated parameters that require using a table to calculate a desired setting.

Parameters with a Visual Programming option display an icon.

To Edit:
1. Left-click on the Visual Programming icon.
2. Click to place an “X” on the appropriate selections.
3. Choose “OK” to accept the change or “Cancel” to abort.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>H1-01</td>
<td>Terminal S3 Sel</td>
<td>25: Multi-Step Ref 2</td>
</tr>
<tr>
<td>H1-02</td>
<td>Terminal S4 Sel</td>
<td>1: Multi-Step Ref 3</td>
</tr>
<tr>
<td>H1-03</td>
<td>Terminal S5 Sel</td>
<td>25: External Fault</td>
</tr>
<tr>
<td>H1-04</td>
<td>Terminal S6 Sel</td>
<td>Not Used</td>
</tr>
</tbody>
</table>

Security / Password Protection

The “Preferences” drop-down menu allows you to set the access level, username, and password.

By logging out of Advanced mode, you will be sent to User mode. While in User mode, the drives can only be monitored. Write to VFD and Reset functions are NOT available.

Parameter File Comparison

The “Parameter File Comparison” function, found in the “Tools” drop-down menu, allows for comparison of two different parameter files. Use the “Load” button to select the file you want to view on the left and right side.
Once the parameter files are loaded, you can use the “Show” drop-down to compare:
- all parameters of each file,
- only parameters with equal values,
- or
- only parameters with different values.

Parameters shown in Red are parameters with different values.
Chapter 5 - Monitor Function

Monitor

The “Monitor” function, in the “Tools” drop-down, displays a select number of monitor parameters (U-parameters) that are continually updated.

Fault Reset

In the event of a fault condition, you will see the fault icon on Monitor window, as indicated below.

You can reset a fault in the Monitor window, as long as the drive doesn’t have a Run command and the fault condition no longer exists. Once you click on the fault reset icon (as shown above), a warning message will prompt you to accept that you acknowledge the warning. When resetting a fault remotely, you need to be sure that all personnel and/or operators are notified. Once you have checked the “I Accept” box, the “Continue Fault Reset” button will be available.
Chapter 6 - Additional Menu Features

Print Preview

IMPULSE®·Link 4.1 Basic provides a compact printing mode that displays all drive parameters in only 1-2 pages. It also prints a more detailed mode that lists descriptions as well as units for each parameter.

Compact Parameter Print Preview

![Compact Parameter Print Preview Image]

Detailed Parameter Print Preview

![Detailed Parameter Print Preview Image]

Print

Printer Name – Select a printer.
Print Mode - Allows the user to choose the printing style.
  o Compact mode (1-2 pages) provides parameter name and setting value.
  o Detailed mode provides parameters, descriptions, setting, values, and units as well as “modified” information.
  o As shown prints all of the information as shown on the screen.

OK – Prints the active parameter set to the selected printer in the chosen format.

Cancel – Closes this dialog box without printing. Changes to Customer Name, Application, and Job Number are not saved.

Text placed in the Customer Name, Application, and Job Number fields appear on the printout.

NOTE: Only parameters that are viewable in the Parameters Window will be printed.
Parameter File Conversion

The “Convert” function, under the “Tools” menu, allows parameter files to be converted from one firmware version to another (within the same drive series).

![Parameter File Conversion](image)

- **Source** – Specifies the file to be converted.
- **Flash ID** – Specifies the firmware version that the file will be converted to.
- **Destination** – Specifies the Destination location and filename.
- **Convert** - Converts the parameter file specified in “Source” to the format specified in the firmware version in the Flash ID. The converted file is saved to the filename and location specified in “Destination”.

Keypad Simulator

The “Keypad Simulator” function communicates with an IMPULSE®•G+/VG+ Series 3, IMPULSE®•G+/VG+ Series 2, and IMPULSE®•P3 Series 2 drive exactly as the physical keypad does. This allows for remote keypad menu navigation.

**NOTE:** This function is only available when IMPULSE®•Link 4.1 Basic is connected via the drive’s keypad 1CN connector (instead of the standard RS-485 connection) – primarily for training purposes.

If you attempt to run the keypad simulator while connected via a RS-485 connection, a CF00 Comm Error will occur.

![Keypad Simulator](image)

**Keypad Simulator NOTES:**

1. To Activate, select the correct drive profile from the dropdown and click the ▶ button.
2. The Keypad will automatically close if any communication function, such as Upload and Download, or a new offline parameter set is created from the Controller Properties window.
3. The RUN command has been disabled for safety reasons.
4. If the drive is put into “Program Mode” and not returned to “Run Mode”, the user will be unable to run the drive.
Viewing Parameters

The “View” drop-down box allows filtering of parameters based on parameter group or by modified from factory defaults or from custom defaults.

Copying to the Clipboard

The user has the ability to copy displayed parameter information to a preferred word processor or spreadsheet.

To do this, select one or more rows and either press Ctrl-C or right-click to display the context menu, shown to the right. The copied information is available to be pasted in either HTML format or ASCII text.

**Tip**: Change from full row selection mode to single cell selection mode by doing the following:
1. Click and hold the left mouse button over any row.
2. Drag the mouse down while the left-mouse button is still being held. An icon will replace your mouse pointer.
3. While still holding the left mouse button, click the right mouse button. The icon will become skinner and you will no longer be restricted to selecting the whole row. Repeat to return to full row mode.
Chapter 7 - Troubleshooting

The IMPULSE®-Link 4.1 Basic Help section provides the following:

- Reference to Drive faults and corrective actions.
- Reference to IMPULSE®-Link error codes and corrective actions.
- Communication profile settings overview.

Drive Fault References

IMPULSE®-Link 4.1 Basic offers built-in Help screens for the drive faults and alarms. The Help screens provide advanced diagnostics allowing you to troubleshoot your drive from your PC. When you click on the fault, the help screen provides the fault code, fault name/description, and the corrective action.

Or you can simply go to the Drive Fault References for a complete list of faults specific to the individual drive.
Communication Error References

The Help function provides an overview of possible errors that could occur in IMPULSE® Link 4.1 Basic:

By clicking on the type of error, you will be provided the fault code with description and corrective action.
Communication Profile Test

The “Communication Profile Test Utility” is a tool to assist in troubleshooting communication difficulties. It performs the following sequence:

1. Opens the communication port with the selected settings. If the port opens successfully, the port exists and IMPULSE®-Link has access to it.
2. Sends a loop-back test message to establish whether a valid device exists with the settings in the profile. If the loop-back fails, the device may not be powered, present or supported.
3. Identifies the drive model and version. If the discovered type is unknown, IMPULSE®-Link does not support it.

NOTE: If any of the above steps fail, an error message is prompted to the user with an error code (i.e. CE100). For further troubleshooting reference the error code in the help section.

Status Log

This function, also found in the “Tools” drop-down menu, brings up an additional window showing various status details of IMPULSE®-Link 4.1 Basic.